Chapter 1 The TIMS Workplace

TIMS enables you to add, edit, retrieve, and report information about people associated with
tuberculosis quickly and easily. These people may include tuberculosis patients, healthcare
workers providing tuberculosis—related services, persons who have been in contact with
tuberculosis, etc. The user interface, called the TIMS Workplace, consists of a series of
windows, dialog boxes, and program controls that enable you to enter data efficiently, retrieve it
easily, and store it safely and securely.

Note: When running TIMS under Windows 95, Windows 98 or Windows NT 4.0, the lower
portion of the TIMS Workplace may be hidden by the Windows Taskbar. To prevent this, click
the Start button on the taskbar, and then select Settings and Taskbar.
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Chapter 1 — The TIMS Workplace

Starting TIMS

Windows 95, Windows 98, or Windows NT

Follow these steps to start TIMS on Windows 95, Windows 98, and Windows NT Workstation
4.0.

To start TIMS...
1. Click the Start button on the Windows taskbar.

k| Etartl

2. Click the Programs folder to open it.
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3. Click the TIMS program folder to open it.

4. Click the TIMS icon.

S TIMS

Or
Double-click the TIMS icon on the desktop
The TIMS Database Security screen will appear.
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5. Review the TIMS Database Security warning statement.
6. Click the YES button to proceed to the login screen.
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TIMS Login

TIMS requires that you identify yourself to the system before it will allow you access to its
functions. This procedure, called login, uses your User Identification (User Id) and password to
determine what features you have access to, and will provide the System Administrator a record
of all your TIMS activity.

User Id

A TIMS System Administrator assigns your User Id and initial password (see Chapter 7 -
System Module for information on changing your password). User Ids must have between six
and ten characters and can be any combination of letters, numbers, and special characters.
Passwords may also have any combination of letters, numbers, and special characters, and must
contain between six and fifteen characters.

User Levels

There are four security levels for TIMS users:

Name Privileges

Low Can view most client information, but cannot add or change any client
information. Is eligible to view HIV information. Can change their
own password, but cannot perform any other administrative function.

Medium Can enter most client information and is eligible to view client HIV
status. Cannot modify client disposition. Can modify their own
password, set preferences, perform Ad-Hoc queries, and perform other
administrative tasks.

High Can add, edit, and delete all tuberculosis and related information but
cannot perform system administration duties, such as adding and
deleting TIMS user accounts.

System User with System Administrator privileges can perform all TIMS
Administrator functions, including adding and deleting users, assigning user
privileges, deleting surveillance records, client records and
manipulating other sensitive information.

See Appendix Sys | Security Table for a complete list of security privileges.
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Login

The TIMS Login screen is the second window that you will see upon starting the TIMS
application. You must login to use TIMS.

To loginto TIMS...

1. Type your User Id in the User Id field.

A TIMS System Administrator assigns User Ids. The User Id must be entered exactly as it was
given to you.

2. Type your password in the Password field.
Passwords are not case-sensitive: PASSWORD = password = PassWord

TIMS Login
User Id: I ok
Paszsword: I Lancel I

3. Click the OK button.
Logout
There is no logout command for TIMS. If you must logout of TIMS, close the application.

See Iater in this chapter.
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Gathering TIMS Data

TIMS accepts and processes many different types of information. To assist in the data gathering
process, TIMS includes a series of paper-based forms. The TIMS forms are located in Appendix
V of this User's Guide. Please feel free to make copies of these forms to assist in your data
collection efforts.
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The available paper forms are:

»=  Appointment Form = Bacteriology Form

» Blood Test Form » Chest X-Ray Form

=  Client Form = Contact Form

» Diagnosis Form » Drug Pickups Form

= History Form = HIV Test Form

» Hospitalization Form » Physical Exam Tests Form
» Medication Form = Skin Test Form

» Referral Form =  Susceptibility Form

Additionally, TIMS is designed to use data from standard tuberculosis data gathering and
reporting forms.

They are:
= Report of Verified Case of Tuberculosis (RVCT)
= [|nitial Drug Susceptibility Report (Follow Up Report — 1)
= Case Completion Report (Follow Up Report — 2)
= Aggregate Reports for Program Evaluation (ARPE)
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Common Workplace Elements

The visible part of a computer application, the windows, menus, buttons, and other on-screen
items are called the user interface. You use the user interface to interact with the application.
Refer to the following diagram and definitions for details.
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Title Bar - Displays the module name and the active TIMS window.

Control Menu -Open the Control Menu by clicking the icon in the upper left corner of the
window. The Control Menu provides access to window-related functions such as size, move,
and close.

Move
Size

b inimize
b aimize

Cloze  Alt+F4

Restore — Select the Restore command to change a window to its previous size. The Restore
button only appears after a window has been maximized.

Minimize Button - Select the Minimize command to reduce the application window to an icon.
The TIMS icon will appear on the taskbar (the bar usually found at the bottom of the screen that
contains the Start button). To reverse the minimize operation; click the icon on the task bar.

Maximize Button — Select the Maximize command to expand the window to its maximum size
in the current context. If you click the maximize button of a main window, it will expand to fill
the entire window.

Close Button - Select Close to exit the TIMS application.
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Menu Bar - The Menu Bar displays the TIMS command menus. Each module has its own set
of menus and menu options.

Toolbar - The Toolbar displays a series of module-specific buttons that provide single-click
access to frequently used program functions. Each module has its own toolbar.

Focus Line - The Focus Line displays the currently active client, worker, or site, depending on
which module you are in.

Clients are displayed in the Client, Surveillance, and Patient Management modules. Users
can select or change the active client by clicking the Change Focus button on the toolbar.

Workers are displayed in the Daily Program Operation module. Users can select or change
the active worker by clicking the Change Focus button on the toolbar.

Sites are displayed in the System module. Site information is assigned when TIMS is
installed and cannot be changed by the user.

Window Area - The Window Area contains the documents, forms, and dialog boxes you need to
work with TIMS.

Using the Menu Bar

The menu bar is used throughout TIMS and most other Windows applications. It contains a
series of menu names that display a list of related commands and options. The menu bar
displays different options to match the function of the current module.

Menu Operation: Mouse

To operate the menus using the mouse...
1. Click the menu name on the menu bar to open it.

LClient  “Window Help
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2. Click an option on the menu to select it.
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Menu Operation: Keyboard
There are several ways you can use the keyboard to select commands from the menu bar. For
example, you can press the Alt key to activate the menu bar, and then use the arrow keys to
select the appropriate menu and command. However, a more efficient method is to use the Alt
key in combination with the underline letter in the menu and command names.
To operate the menus using the keyboard...

1. Press the Alt key.

2. While holding the Alt key, press the underlined letter in the menu you want to
open and release the Alt key.

3. Press the underlined letter in the name of the option you want to select.
Using the Shortcut Menu

Many TIMS windows, fields, and other on-screen objects have shortcut menus which provide an
additional way to access commands. Some commands can only be accessed through the
shortcut menu.

The shortcut menu is displayed by clicking the right mouse button.

To use the shortcut menu...

1. Right-click an object in the TIMS window area.
2. Select a command or option from the shortcut menu.
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Using Toolbars

Toolbar buttons provide one-click access to some commonly used TIMS functions. The buttons
that appear will provide module-specific options.

You can find a brief description of the function of specific toolbar buttons by displaying its
ToolTip. ToolTips appear when the mouse pointer is placed over a toolbar button for a few
moments.
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To use a toolbar button, click it one time.

Common Menus

Two menus, Window and Help, appear in all TIMS modules.
Window Menu

The Window menu enables you to change the way the windows within the main TIMS window
are displayed.

Tile
Layer
LCascade

Screen Saver Chlvw/

Tile
Select the Tile command to arrange all open windows so that they don’t overlap.
Layer

Select the Layer command to arrange all open windows so that each window completely
covers the one below it.

Cascade

Select the Cascade command to arrange all open windows so that each window’s title
bar is visible.

Screen Saver

TIMS will automatically suspend operation if there has been no activity for a pre-
determined amount of time (set by a TIMS administrator in the System module).

If you know you’ll be away from the computer, but do not want to exit the application,
you can select Screen Saver to temporarily suspend TIMS operation. You will be
required to re-enter your password before you can resume TIMS operation.

Reactivate TIMS
[PuBLIC 1] 4

Password: I

[” System Administrator

Version 1.10 February 2001 1-9



Chapter 1 — The TIMS Workplace

Help Menu

The Help menu provides access to additional information about operating the TIMS application.

TIMS Databaze Securty
Help Contents
Examplez and Demos
Fieference Infarmation
Technical Help
Glozzan

CueCardz
About TIMS

TIMS Database Security
Select TIMS Database Security to view the security clause.

Help Contents
Select Help Contents to see the TIMS Help Contents.

Examples and Demos
Select Examples and Demos to display sample TIMS windows.

Reference Information

Select Reference Information to access information and tips about the TIMS
Workplace, general data entry suggestions, keyboard guide information, and tips on how
to use the TIMS Help System.

Technical Help
Select Technical Help to get information on whom to contact for help.

Glossary

Select Glossary to display an alphabetized list of terms associated with TIMS program
operation, tuberculosis, and other TIMS-related topics.

CueCards

Select CueCards to set preferences for TIMS CueCards, which are small help screens
designed to prompt you to perform certain commonly used actions within the TIMS
application.

About TIMS
Select About TIMS to display TIMS version and TIMS Help Desk information.
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Selecting a Client or Worker (Change Focus)

Most TIMS activity will apply either to a client or a worker. The Focus Line enables you to
immediately identify whether you are working in the client section or in the worker section, and
whose record the current action is affecting. Client records can be accessed in the Client,
Surveillance or Patient Management modules. Worker records can be accessed in the Daily
Program Operations module.

Change Focus (Client)

To change client focus...
1. Do one of the following:
= Click the Change Focus button on the toolbar.

Or

= Click the Open button on the toolbar.
[~

Or

= QOpen the Client menu and select Open.

[ ]
2. Select a filter (*All’ is the default filter) from the drop-down list.
3. Click Execute to create the selected filter client list.
4. Select a client from the list.
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5. Click OK or double-click on the client to open.
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After a client is selected, the client’s name will appear in the Focus Line. Navigational buttons
are available to move from the Current Client to the Previous or Next Client.

Previous Client %w Next Client
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Change Focus (Worker)

To change worker focus...
1. Do one of the following:
= Click the Change Focus button on the toolbar.

Or

= Click the Open button on the toolbar.
[

Or

= Open the Worker menu and select Open.

2. Select the worker from the list.

workes Ligt
Woskem Hams Wiorker ID Slalur

ATAISOR, PUBLIC HEALTH Acive ;|

3. Click OK.

The worker’s name now appears in the Focus Line.
‘:‘x Daily Program Operations

Worker Heportz  Window  Help

lewRrw= DOBPE0 | B0 &

Current Worker: “WORKER. DEFAULT
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Setting Up Filters

Filters limit the client list to those that fit your specified criteria. This option can only be used
when working with the Change Focus (Client) operation; it is not available with the Change
Focus (Worker) operation.

To set up afilter...
1. Open the Change Focus (Client) mode. In the Select Filter option, ALL is the

default.
Chaege Foeust |
Sebect Filles; [ALL [~ Filtes, .
Client List Execute
Lasi Mame | Fiest Mame DOB  |Stabe Case 8| Clyp/Coly Case 8
wirw |
Seach |
LT |
_Gancel |

2. Click the Eilter button. The Add/Modify Filter window will appear.

050 A dd SH iy Filkeg

Filter Mame: 241 =1 Hew
Filtes Values Camy
[ Fiuld | Dperatos Value ] Connecio| —
L 5 , v |
Irreer]l Hiowe | l:I.l’ﬂ“*'u-| %I
Melete 1] .w| Usage: | B

Mol Dalies shauld be an P lemal Lyppdmm/od]

3. Click the New button. An empty row will appear in the Filter Values box.
4. Assign a Name to the filter and enter into the Filter Name box.
5. Establish the parameters by which you want the filter to execute.
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The following parameters are available to create a filter:
Field provides the ability to filter by the predetermined drop-down options.

Field

Iz
Client Info Last Date Updated =]
Contact
County [hot reparting ar current]
Current County
D ate of Birth
Diagrosis
Digposzition
Firzt Mame j

The Operator field displays predetermined logical numeric operators.

Operator
-

<k
>
=
<
L=

LIKE

NOT LIKE

The Value field displays MISSING (provides data items that are blank) and
NOT MISSING (provides data items that are not blank). You can also type in
the value you want to filter on (e.g. date value).

Yalue

MISSING
HNOT MISSING

The Connector field provides the option of using AND or OR as the
connector for your filter.

Connector

|~

AWD
oR

The Open and Close Parentheses can be used to group filter criteria.

)

Insert another row to create another filter criteria by clicking the Insert Row
button. (A row may be deleted by clicking the Delete Row button).

Click the Save button.

Click the Close button and the system will return to the Change Focus window.
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9. Click the Execute button to display a list of clients that meet the parameters
established in the newly created filter.

Chamgs Focus

Select Filker: BINGO | Filber,.
Client List Execute
LasiMame |  FiustMame | D08 |Siste Case #| Cip/Coly Caze 8

ERALY PETER (420111940 =

COMTACT JAHE 201 A1 %30 -

COMTACT JDANME 04191960

COMTACT M0E 020 1360 v

CUBMINGHAM RICHIE 0427 11965 e
ALY MAFSHA 010 A1 Seach

NOT T8 DELE TED LY OME 02/29/1976 O0000808

TEST CLENT 101 01578 D055

FADS FS0 114211330 OO0 5F0IS

CLIEMT NOSHDW IRS R F S ] (aCEa0ES -

i
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Using CueCards

CueCards are very brief prompts that remind you how certain operations are performed. A
module-specific CueCard displays each time you enter that module. The CueCard that appears
after you login to TIMS displays tips from several different modules.

o Welcome to TIMS M B3

To find out how to begin a tazk in TIMS, click on
the action listed below.

5| New Cliens

| Edi Cient

EI Enter Patient b anagement D ata
8|Ener s RVET

%Ihdd I e whorkoer

B Edit worker

| Uncheck if you don't want this CueCard to show again.

LClose

Click an icon or green underlined text to see additional information.

To edit an existing client's demographic information

1. Change ta the Client Madule by selecting Clisnt fram the TIMS Baze
Menu; OR

Click the Client Module izon on the toolbar.
2. Select the Edit option from the Client Menu; OR

Click. the Edit Client Information icon o the toolbar.
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Adding / Removing CueCards

Once you are accustomed to TIMS, the CueCards may become unnecessary. There are three
ways to prevent CueCards from displaying.

To display or remove CueCards...

3.

= Clear the check box near the bottom of the Welcome to TIMS window to
prevent that particular CueCard from displaying in the future. This procedure
must be repeated for each CueCard.
Or
Open the Help menu and select CueCards.
Select the appropriate check box to display the associated CueCard when you
open the appropriate module.
Clear the check boxes to prevent that CueCard from displaying.

CueCards Preferences

— CueCards
v Main

v Client
v Patient Management
¥ Surveillance

¥ Daily Program Operations

Mote: To show the CueCards. check the boxes of the

caresponding modules.
_lganCEI

Click OK.
Or

(Note: The user must have medium or higher user privileges to use this method.)

Mo

Open the System module.

From the System Mgt menu, select Preferences.

Click the CueCards button.

Select the appropriate check box to display the associated CueCard when you
open the appropriate module.

Click OK.

Clear the check boxes to prevent the CueCards from displaying.
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Changing Modules

You can select different TIMS modules by clicking the command menu on the left side of the

window.

Command

Menu Module(s)

TIMS Client, Surveillance, Patient Management, Daily Program Operations, System

Client Client, Surveillance, Patient Management, Program Evaluation, Daily Program
Operations, System

Worker Client, Surveillance, Patient Management, Program Evaluation, System, Daily Program
Operations

System Client, Surveillance, Patient Management, Program Evaluation, Daily Program

Operations

You can also change modules by clicking a button on the toolbar. The module buttons are
always on the left side of the TIMS toolbar.

Program Evaluation
System
Surveillance }—\

i?f_ E:::E- ||E|T|
Client }—‘ H Daily Program
Patient Operations
Manaagement

To change to a different module...

1.

3.

Save any currently open documents by clicking the Save button on the individual
TIMS windows. If the Save button is disabled, the information on the window
has not been modified since the last time it was saved.

Select the desired module from the command menu or click the appropriate
button on the toolbar.

All opened windows will be closed when you change modules. If you are
changing between module types, the current client, worker, or site will be closed.
Click the OK button to close the windows.

= Changing Module

All Opened Windows Will Be Closed Before
Changing to Another Module.

| OK! | ‘Cancel‘
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TIMS Module Selector

The TIMS Module Selector window appears immediately after you login to TIMS. The Module
Selector window acts as a gateway to the other modules.

The Module Selector toolbar and menu options are available in all TIMS modules.

i Nubsecubag lebe e Harsgasan Siras

Dds Help:
apRBulT ¥
Toolbar

The Module Selector toolbar allows you to change to a different module by clicking a button on
the toolbar. The Module Selector toolbar buttons are available in every TIMS module.

Patient Management
Module
_ Daily Program
Client Module H ﬁ Operations Module

el [3] L= W 1] el R vew

L{ System Module
Surveillance Program
Module Evaluation
Module
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Module Overview

TIMS is divided into several modules that separate the functions of the TIMS software. The
modules are Client, Surveillance, Patient Management, Program Evaluation, Daily
Program Operations, and System.

Client

Use the Client module to keep track of demographic and other information about persons
receiving tuberculosis - related services from your facility. Unlike the other modules, the
functions of the client module are available in all client-related modules. The client-related
modules are Surveillance and Patient Management.

Surveillance

Use the Surveillance module to complete electronic versions of standard tuberculosis
tracking documents such as Report of Verified Case of Tuberculosis (RVCT), Initial Drug
Susceptibility Report (Follow-Up Report - 1), and the Case Completion Report (Follow-Up
Report - 2).

Patient Management

Use the Patient Management module to record additional information about clients, such as
their TB diagnosis, the tests they have received, and the medications they are receiving.

Program Evaluation

Use the Program Evaluation module to enter data into the Aggregate Reports for Program
Evaluation (ARPE), and transmit them to the reporting area (if applicable) and CDC.

Daily Program Operation

Use the Daily Program Operation module to enter information about your facility and the
people who work there.

System

Use the System module to manage the TIMS system and data, customize TIMS operations,
change your password, and transfer TIMS data to the CDC.
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Client Module

Use the Client module to track information about clients. The functions of the Client module
are available in the other client-centered modules (Surveillance and Patient Management).

Client Toolbar

The functions on the toolbar displayed in the Client module are available in the other client-
centered modules. The Module Selector buttons are also available.

. Open .
New Cllent}— ﬁ Client ﬁ Appointments
: v Change
Do o Qlﬂ Focus

Edit Client Close Client

Client Module Menus
The Client Module has three menus: Client, Window, and Help
Client Menu

The Client Menu enables you to create new client records, edit identification and demographic
information, view client origins and final outcomes, and change between TIMS modules.

New
Select New to create a new client record.

Edit
Select Edit to modify an existing client record.

Open
Select Open to open a client record for viewing or modification. This command operates
the same as Change Focus.

Close
Select Close to close the current client record. This removes focus from the current
client. All open windows will be closed.

Previous
Select Previous to move to previously viewed client record.

Next
Select Next to move to the next client record.

Origination
Select Origination to view or modify the client’s origins (former contact, transferring
from another location, etc.).

Disposition
Select Disposition to record the final outcome for a client (completed therapy, died,
moved, etc.).

Appointments
Select Appointments to add, edit, void, delete, confirm, reschedule, or check - in client
appointments for tuberculosis-related services.
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Transfer
Select Transfer to record a movement from your facility to another tuberculosis
treatment center. This option is not available in the current version of TIMS.

Print Setup
Select Print Setup to select from the printers currently defined in your system and to
make modifications to printer settings. Printer settings are printer and operating system
specific.

Other Menus

The Window and Help menus are common to all TIMS modules. See Common Menus earlier in
this chapter for details.
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Surveillance Module

Use the Surveillance Module to complete electronic versions of the Report of Verified Case of
Tuberculosis (RVCT), Initial Drug Susceptibility Report (Follow Up Report - 1), and Case
Completion Report (Follow Up Report - 2). The information entered into the Surveillance
module can be transmitted to the CDC.

Surveillance Toolbar

The Surveillance module toolbar has seven unique functions. The toolbar also contains options
for changing modules and adding and editing clients.

Create or_Edlt Case SURVS-TB UDV
Completion Report

Surveillance

Create or Edit RVCT }— ;'i,'f;l !‘l @l | %l El]]l 2 Record

Deletion

Browse Surveillance

Create or Edit Initial
Documents

Drug Susceptibility
Report
Case Verification

Surveillance Menus

The Surveillance module has seven menus: Client, Surveillance, Data Generation, Data
Transfer, Reports, Window, and Help.

Surveillance Menu

The Surveillance menu enables you to create and edit surveillance documents for the current
client.
Report of Verified Case of Tuberculosis (RVCT)
Select Report of Verified Case of Tuberculosis to add or edit a client’s RVCT.

Initial Drug Susceptibility Report (Follow Up Report - 1)
Select Initial Drug Susceptibility Report to add or edit a client’s initial drug
susceptibility report.

Case Completion Report (Follow Up Report - 2)
Select Case Completion Report to add or edit a client’s case completion report.

Case Verification
Select Case Verification to add, edit, or view case count information.

SURVS-TB UDV
Select SURVS-TB UDV to view or edit the user-defined variables imported from the
SURVS-TB system.

Browse
Select Browse to see a summary of all surveillance documents entered in TIMS.

Surveillance Record Deletion

Select Surveillance Record Deletion to mark for deletion and to purge surveillance
records from your TIMS database.
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Data Generation Menu

Use the options on the Data Generation menu to import related information from the Patient
Management module. This will prevent duplicate data entry.
Generate
Select Generate to import data for the active field.

Generate All
Select Generate All to import all relevant data from the Patient Management module.

Clear Generated
Select Clear Generated to remove the imported data from the active field.

Clear All Generated
Select Clear All Generated to remove the imported data from the entire document.

Data Transfer Menu

The options on the Data Transfer menu are used to prepare surveillance data to be transmitted to
the CDC through a hierarchy of reporting agencies. The two options on the Data Transfer menu
are NETSS and Surveillance.

NETSS

The NETSS (National Electronic Telecommunication System for Surveillance) option is
available at the Reporting Area only. It produces a sub-menu of three options for
diskette-based data transfer:
Weekly
= Select Weekly to transmit data for the past week for inclusion in the MMWR.
Year-to-Date
= Select Year-to-Date to prepare to transmit all surveillance data collected from
the beginning of the current MMWR year until the current date.
Archived
= Select Archived to re-send data that was damaged or lost for inclusion in the
MMWR.

Surveillance

Select Surveillance to prepare surveillance data to be transmitted electronically to the
next level reporting site. The actual transmission occurs in the System module.
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Reports Menu

The Reports menu displays a set of module-specific summary or detail reports:

Case Verification Report
Counted Cases Report

Not Counted Cases Report
Demographics Report
Clinical Data Report

Case Follow-Up Report
Completed RVCT Records
Incomplete RVCT Records
Facsimile Report
Updated-In-Session Report
Deleted Records Report
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Patient Management Module

Use the Patient Management module to store and maintain tuberculosis-related information
about clients who receive treatment or evaluation at your facility. The information in the Patient
Management module is for your records and is not used as official surveillance data, nor is it
transmittable. However, you can import relevant Patient Management information for use as
surveillance data by using the Generate command in the Surveillance module.

Patient Management Toolbar

The Patient Management module toolbar has six unique functions. The toolbar also contains
options for changing modules and adding and editing clients.

Bacteriology Chest X-ray
Contacts% .ﬁl _R‘l Ql }l ml m Test Summary

MedicationsH L‘ Skin Test

Patient Management Menus

Profile Menu

Use the options on the Profile menu to record personal information about the client such as their
tuberculosis diagnosis, tuberculosis history, contacts, etc.
Contacts
Select Contacts to record information about persons who may have been exposed to
tuberculosis through their association with the current client.
Diagnosis
Select Diagnosis to record one or more tuberculosis-related diagnoses for the current
client. A valid diagnosis is required to enter certain other Patient Management
information.
History
Select History to record relevant tuberculosis-related medical information about the
current client.
Hospital/Facility
Select Hospital/Facility to record information about medical facilities where the current
client has received any medical treatment in the recent past or during TB treatment.
Referrals

Select Referrals to record information about the person or organization that
recommended that the current client visit your facility for tuberculosis evaluation or
treatment.
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Therapy Menu

The options on the Therapy menu allow you to view, add, and modify information about the
tuberculosis treatment regimen the current client is receiving.
Medications
Select Medications to add, edit, and view information about the current client’s
tuberculosis drug regimen.
View Pick-Up/Delivery
Select View Pick-Up/Delivery to display a drug pickup and delivery summary.

Tests Menu

Use the options on the Tests menu to record, edit, and display information about tuberculosis-
related tests that have been administered to the current client.
Bacteriology
Select Bacteriology to record, edit, or view bacteriological specimens and drug
susceptibility test results.
Blood
Select Blood to record, edit, or view blood test results.

Chest X-Ray
Select Chest X-Ray to record, edit, or view chest radiograph results.

HIV
Select HIV to record, edit, or view HIV test results. This command will not be available
if the user does not have HIV viewing privileges.

Physical Exam
Select Physical Exam to record, edit, or view the results of tuberculosis-related physical
examinations.

Skin
Select Skin to record, edit, or view the results of tuberculosis-related skin tests.

Test Summary

Select Test Summary to view a summary of all tuberculosis-related test data that has
been collected for the current client. This command will not be available if the user does
not have HIV viewing privileges.
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Reports Menu

The Reports menu displays a set of module-specific summary or detail reports:
= Adherence: Appointments

= Adherence: Assigned Workers - This report is not available in the current
version of TIMS.

= Adherence: Medication Metabolite
= Contact Report

» Medical Report: Summary

= Medical Report: Blood Tests

» Medical Report: HIV Tests

= Medical Report: Skin Tests

» Medical Report: X-Ray Tests

=  Therapy: Medication

» Therapy: Medication Outcome
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Program Evaluation Module

Use the Program Evaluation module to create, maintain and transfer Aggregate Reports for
Program Evaluation (ARPE).

Program Evaluation Toolbar

The Program Evaluation toolbar contains functions to create the following reports, Follow-up
and Treatment for Contacts to Tuberculosis Cases and Targeted Testing and Treatment for
Latent Tuberculosis_Infection.

Program Evaluation Menus

The Program Evaluation module has four menus: TIMS, Reports, Window and Help.

Reports Menu

The Reports menu displays the specific reports available for Program Evaluation including:
* Follow-up and Treatment for Contacts to TB Cases and

e Targeted Testing and Treatment for Latent TB Infection

E-U Program E valuation

T Suniel "Aindow  Help
JI o | Eollaw-up and Treatment for Contacts to TE Cazes
e T argeted Testing and Treatment for Latent TE Infection
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Daily Program Operations Module

Use the Daily Program Operation module to store and maintain information about the staff at
your facility.

Daily Program Operations Toolbar

The Daily Program Operation toolbar has one unique feature, Worker Assignments. The rest of
the tools are variations of the functions found in the client-centered modules, applied to workers

instead of clients.
Edit WorkerH F{ Close Worker

NewWorker}» 0 | ﬁ:l E‘l I"__"II ﬁl | ﬁl# Egs:sge

Open Worker}—‘ Worker % # Worker

Assignments Appointments

Daily Program Operations Menus

The Daily Program Operations module has four menus: Worker, Reports, Window, and Help.

Worker Menu

The Worker menu duplicates the function of the Client menu in the Client, Surveillance, and
Patient Management modules, with a worker focus.

New
Select New to create a new worker record.
Edit
Select Edit to modify an existing worker record.

Open
Select Open to open a worker record for viewing or modification. This command
operates the same as Change Focus from the toolbar.

Close

Select Close to close the current worker record. This removes focus from the current
worker.

Assignments

Select Assignments to assign workers to individual clients. These assigned workers will
then provide tuberculosis-related service to those clients.

Appointments

Select Appointments to create, edit, or display appointments assigned to the current
worker. All client related appointments are scheduled in the client-centered modules.
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Reports Menu

The Reports menu displays a set of module-specific summary or detail reports:
Appointment: By Client - This report is not available in the current version of TIMS.
Appointment: By Worker - This report is not available in the current version of

TIMS.

Assignments: By Client - This report is not available in the current version of TIMS.
Assignments: By Worker - This report is not available in the current version of TIMS.
Assignments: Number and Types of Clients

DOT Summary: By Worker

DOT Summary: All Workers

Exception Report:
Exception Report:
Exception Report:
Exception Report:
Exception Report:
Exception Report:
Exception Report:
Exception Report:

Clients who are smear positive (date range)

Smears pending > X days

Cultures pending > X days

Clients with drug-resistant TB (date range)
Cases/Suspects with no positive bacteriology (date range)
Cases/Suspects without a worker assigned (date range)
Cases/Suspects with no suspects identified (date range)
Clients who have been a suspect for > X days
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System Module

Use the System module to manage TIMS data and set TIMS program options.
System Toolbar

The System module toolbar features eight unique functions.

Outbox
Answer Mode h h ﬁ Ad-Hoc Query
oo - ][R @(|  m[mlw] 2

Inbox }J ) ) H Preferences
Misc. File

Transfer

System Module Menus

The System module contains seven menus: System, Data Management (Data Mgt), System
Management (System Mgt), Administration, Reports, Window, and Help.

System Menu

The System menu contains eight items; of the eight, only Transmission is unique to the System
module. The others, Print Setup, Client, Surveillance, Patient Management, Daily Program
Operations, Program Evaluation, and Exit are common to the first menu in all TIMS modules.

Transmission
The transmission menu provides access to six data transmission-related options:
Dial
Use the Dial command to connect with another TIMS system for an outgoing
data transmission.
Answer
Use the Answer command to set the TIMS system to receive incoming data
transmissions.
Inbox
Use the Inbox command to open the TIMS Inbox. The Inbox contains data files
transmitted by lower-level sites.
Outbox
Use the Outbox command to open the TIMS Outbox. The Outbox contains any

data files that are waiting to be transmitted to another site. Once transmitted the
data are removed from the Outbox.

Misc. File Transfer (Miscellaneous File Transfer)
Use the Misc. File Transfer command to send non-surveillance data files to

another site. Any kind of file, spreadsheets, graphic, word processing documents,
etc. can be transmitted using the Misc. File Transfer command.

COMM Port Settings

Use the COMM Port Setting to adjust your modem setting to allow you to send
and receive data successfully.
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Data Management (Data Mgt) Menu

The functions on the Data Mgt menu enable you to access TIMS information in ways that are
not available in the rest of the application. Only users with High or System Administrator
security privileges can access these functions.
Ad-Hoc Queries
Select Ad-Hoc Queries to create and save data queries not available as standard TIMS
reports.
Frequency Report
Select Frequency Report to create and save frequency data queries.

Data Dictionary
Select Data Dictionary to display technical details about the tables and fields found in
the TIMS database.

Export
Select Export to copy TIMS data to a different file in a choice of file formats.

User-Defined Variables
Select User-Defined Variables to add custom data entry fields to specific TIMS
windows.

Database Backup
Select Database Backup to copy your TIMS data to diskette or other data storage device
so that data are not lost if there are problems with the TIMS database.

Database Recovery
Select Database Recovery to restore your TIMS database from a copy made using the
Database Backup command.

Purge Records by Site
Select Purge Records by Site to permanently remove records for lower site(s).

Purge Client Records

Select Purge Client Records to permanently remove clients without surveillance
information.

1-34 TIMS User’s Guide



Chapter 1 — The TIMS Workplace

System Management (System Mgt) Menu

The functions on the System Mgt menu enables you to change your password, set system
options, and correct problems with the TIMS system.
Diagnostics
This feature is not available in the current version of TIMS.

Preferences
Select Preferences to set system options such as file location, record search
specifications, etc.

Security
Select Security to change your TIMS system password. System Administrators can use
the Security option to add or delete users, or change their system privileges.

Site Information
This feature is not available in the current version of TIMS.

Administration Menu

The functions on the Administration menu allow you to convert data from SURVS-TB (an older
CDC tuberculosis data system), create reporting sites, and other administrative tasks.
Data Conversion
Select Data Conversion to convert data from SURVS-TB (no longer utilized since all
SURVS-TB data have been converted).
Spin-Off Diskettes
Select Spin-Off Diskettes to register lower-level reporting sites within your jurisdiction.
This option is only available to Reporting Area TIMS system administrators.
Table Maintenance

Select Table Maintenance to modify the options available from some drop-down lists
within the TIMS application.

Reports

The System module can produce several administration and data transmission related reports:
= Activity Log » User-Defined Data Dictionary: Global
= Transmission Log = User-Defined Data Dictionary: Local
= Users Rights / Access = Unacknowledged Record Report

Unacknowledged Transfer File Report
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Working With Reports
A report is an organized and effective way of presenting pre-selected data in a printed format.
Reports organize the data to maximize readability.

Reports operate differently than other TIMS components. They are controlled entirely by a
series of buttons near the bottom of the reports window.

All reports have the same controls

Last Page

Previous Page| Print Report

First Page Close Report

Next Page Adjust

Magnification

Some reports allow you to cycle through multiple clients with the Previous and Next buttons.

Previous Client %w Next Client

Some TIMS reports will have more than one page. The navigation buttons at the bottom of the
report screen allow you to change report pages quickly and easily.

Navigate through a Report

To move forward one page...
= Click the Next Page button

13

To move backward one page...
= Click the Previous Page button.

To move to the last page in the report....
= Click the Last Page button.

To move to the first page in the report...
= Click the First Page button.

Kl
v
]
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Print a Report

To print a report...
1. Open the report.
2. Click the Print Report button

Sl

TIMS allows you to adjust the magnification of the viewing area.

Adjust Report Magnification

To adjust a report’s magnification...
1. Open the report.
2. Click the Adjust Magnification button.

This displays the Print Preview dialog box.

3. Select Magnification settings from the preset options or enter your own in the
Custom box.

Print Preview

— Magnification
 200% Cancel
c w0 Efeiem
B8 %
¢ Custom m% Cancel |

4. Click the OK button.
Adjust Report Margins

You can temporarily adjust the margins (the area between the printed material and the edge of
the page) by dragging the margin indicators to a new location on the horizontal and vertical
rulers. The margins will return to their default location the next time you run the report.

1. Open the report.

2. Click the Adjust Magnification button.

2]

This displays the Print Preview dialog box
3. Select Show Rulers.

4. Click OK.
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5. Drag the double-headed arrows to a new location to adjust the report margins.

Use the double-headed
arrows to adjust the borders

Appointments Report

.|.I .|.|.I.|1.|.|.I.|.|.|.I.|2.|.|.I.|.|.|.I.|§|.|.I.|.|.|.I.|'.1|.|.I.|.|.|.I.|!

e

=== Confidential Baticnt Information =
APPOINTMENT REPORT

1 CLIENTNAME: Erett Baulor

CITCOUN TS
STATE CASE #:47D230719 CA3E
SITE [(IMSTALLATION]: SRECIAL &
G Dewt. of Public Health Diuriket

6. Follow the normal procedure to print the report.
The printed report will print with the newly adjusted margins.

Close a Report

To close a report...
= Click the Close Report button.

Ld
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User-Defined Variables

If your facility gathers tuberculosis-related information that is not ordinarily part of TIMS, user-
defined variables provide a place to store custom site-specific information. The TIMS System
Administrator can define up to five user-defined variables for the 18 TIMS windows that will
accept them. Not all TIMS windows can have user-defined variables.

Most TIMS windows have small user-defined variable buttons on them, usually on the right side
of the window. All user-defined variable buttons depict a sheet of paper, with several variations.

& Client Aliases

El User-Defined
Last Name |  First Name | M_I. | Date of Birth Variable

Bayless Jon 05,/05/1965
Klirg Raobert 00/00,/0000 New |
Lil B 00,00/0000

Delete

UL
_Close |

Last Mame: IB ayless

First Name: pﬂn

) LCloze
Middle Name: I

Date of Birth: IDEF’D5”955 E

There are three variations of user-defined variable buttons, each with a different meaning.

El Buttons depicting a blank sheet with an X through it indicate that you must select a
specific record to activate the user-defined variable for the current window.

Dl Buttons with a blank sheet indicates that the user-defined variable associated with the
currently selected record does not contain data.

Buttons with a striped sheet indicates that the user-defined variable associated with the
currently selected record contains data. Clicking the user-defined variable button will
allow you to view, edit, or delete the information it contains.
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Using User-Defined Variables

To enter information in a user-defined variable...
1. Click the User-Defined Variable button on the window.

Is

If the user-defined variable is required, the User Defined Fields for Client Information Table
dialog box will appear automatically. You will not have to click the button.

2. Complete the information that appears in the Global User Defined Fields dialog
box.
Each dialog box will have a unique appearance.

&% User Defined Fields for Client Information T able
Global User Defined Fields

OHD SEVERITY CODE Char 3 |053

DATE SEVERITY CODE ASSIGNED Date 0241211938

Local User Defined Fields

TB REVIEW DATE Date 0573171336

it OF HOUSEHOLD MEMBERS Mumber [ 700000
TB REGIMEN CODE Char 8 [RPs0E08

IS THE CLIENT COOPERATIVE? Yes/No/Unk [v

Save Close

There are four types of controls available on a user-defined variable window.

The number and type of options that appear on your window depend on the TIMS

System Administrator at your site, and the TIMS System Administrator at the

Reporting Area level.

= Char - Enter any combination of numbers, letters, and special characters up to
the maximum number specified to the left of the character field.

= Date - Enter a date in DD/MM/YYYY format.

= Number - Enter a number

* Yes/No/Unk - Enter Y for yes, N for No, and U for unknown.

3. Click the Save button.
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Flag Information Window

When a client is in focus, a flag button appears on the Focus Line.

Current Client: Duquesne, Delila =
Flag Button

Clicking the flag button produces a client information summary and displays any alerts (flags)
about the current client. Persons who are able to perceive colors can get an at-a-glance
assessment of the current client’s alert status.

L Green Flag The current client has no active alerts.

| Yellow Flag The current client has a user-defined alert.  This
indicates that some factor about this client should be
noted by workers reviewing his or her record in the
future, but the client has no critical, red flag alerts such
as drug resistant TB.
ﬂ Red Flag Red Flag indicates that the current client meets one or
more conditions to qualify for high alert status.
Conditions which meet these criterion are:
Drug Resistant TB

Non-adherent to treatment regimen
Smear Positive (Bacteriology)

Open the Flag Window

To open the flag window...
= Click the Flag button on the Focus line.
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Client Information Window

The Client Information window provides a summary of useful client information.

bk Clerd Informaline [Wimwe [nly]

MZEIEHI Fiizl: ﬁﬁﬁ Midelle |
Chent |danbfiore
State Case Mumber: | Social Secuily #:[F39839042
City/Courdy Case Mumber: [14 1530557 Dste of Dtk PANASS0 | Age: 8 [§
L1 Racn Eikevic Daigin
T i
 Male T Elack - Hisparsc
i Famale 7 Amemican Indian m Alaskan Mabwa Mol Hisganic
& Unknown 7 Unkneovn  Urdknosen
™ Arian o Pacilic Idander
aviirkis sl [Ridigen L angpaiigie
{5 . Primamy Langpesge |
D ade Emlaned 1.5 WE JUE ) m Closs
™ Mok LIS
I WMnkevien |'I

The window includes:

Identification and Demographic
Information

= Social Security Number

= State Case Number

= City/County Case Number
= Date of Birth

= Sex

Treatment Information

= Workers assigned to client
= Treatment enrollment date
= Client disposition

Alert Information

Close the Client Information Window

To close the client information window...
= Click the Close button.

» Rules-based alerts (based on medical
tests and compliance with treatment)

= User-defined alerts

1-42

TIMS User’s Guide



Chapter 1 — The TIMS Workplace

Using the TIMS Help System

TIMS comes with extensive online help that can assist you in using the application effectively.
There are three levels of TIMS help:

= Subject Level - an overview of a TIMS process.
» Field Level - description of a field or other object on a TIMS window.
=  Task Level - “How To” instruction on how to complete a TIMS task.

There are several ways to access TIMS help.
The Help Menu

The Help Menu provides access to additional information about operating the TIMS application.
Open the Help menu to access the online help.

TItS Databaze Security
Help Contents
Examplesz and Demos
Reference Infarmation
Technical Help
Glozzan

CueCards
About TIMS

TIMS Database Security

Select TIMS Database Security to view the security clause.
Help Contents

Select Help Contents to see the online help Table of Contents.
Examples and Demos

Select Examples and Demos to display sample TIMS windows.
Reference Information

Select Reference Information to access information and tips about The TIMS
Workplace, general data entry suggestions, keyboard guide information, and tips on how
to use the TIMS Help System.

Technical Help

Select Technical Help to get information on database configuration, LAN setup, and
other technical subjects. Also contains information about getting TIMS technical
support.

Glossary

Select Glossary to display an alphabetized list of terms related to program operation,
tuberculosis, and other TIMS-related topics.
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CueCards

Select CueCards to set preferences for TIMS CueCards, which are small help screens
designed to prompt you to perform certain commonly used actions within the TIMS
application.

About TIMS
Select About TIMS to display TIMS version and system information.

Context-Sensitive Help

You can get help on your current task by pressing the F1 key. This displays help relevant to the
task you are performing.

Help from the Toolbar

Click the Help button on the TIMS toolbar to display context sensitive help. This is equivalent
to pressing the F1 key.
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TIMS Help Contents

The TIMS Help Contents screen allows you to access broad categories of TIMS help. Click one

of the links to display additional help.

I . 1 -
fie G Bwipald odes [Zep
e P N e e
TS Help Contents

el senTiple p wnd dersondrebors o Relp o lese TIME

Select Using TIMS to display general and specific information abut TIMS
9 modules.
Select Examples and Demos to display sample TIMS windows which can be
£ clicked to display detailed information about the window.
l-h- Select Reference Information to display answers to commonly asked questions,
tips on using TIMS, and other useful TIMS-related information.
Select Technical Help to display information about phone and e-mail based
support.
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TIMS Help Toolbar

The TIMS help window displays a series of buttons you can use to access several help functions.

Click Contents to display the TIMS Help Contents

Click Search to display a list of TIMS topics, much like an index in
a book.

Click Back to return to the previous help topic.

Click Print to print the current help topic.

Click Glossary to display a list of TIMS and tuberculosis-related
terms and their definitions.

Click Index to display an alphabetical list of TIMS topics.

Help on Help

TIMS uses the standard Microsoft Windows Help system that is compatible with Windows
95/98, and Windows NT. The individual help windows display informative text and graphics
about the application the window was invoked from.

A window may contain one or more links to additional related information. These links may
change the content of the current window, display a new window, or display a pop-up overlay on
the current window. A solid green line, a dotted green line, or a graphic can identify links. The
mouse pointer will always change to a pointing hand when over a link.

2 Using TIMS
Q@\ Ge'™pral and specific instructions on all

You can always get help on using the Windows Help system by pressing F1 while in the Help
system.
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Closing TIMS

When you are finished using the TIMS application, shut it down.
There are three ways to exit the TIMS application...
Menu

To close TIMS using the menu bar...

1. Open the primary menu.
Remember- This is the first menu on the left (TIMS, Client, Worker, or System).

2. Select Exit.
3. Click OK to confirm that you want to end your TIMS session.

TIMS =]

@ Thiz will end your TIMS zeszion.

Cancel |

Keyboard

To close TIMS using the keyboard...
1. Press Alt+F4

2. The OK button is selected. Press Enter to confirm that you want to end your
TIMS session.

Control Menu / Close Button

To close TIMS using the mouse...

Control Menu
1. Double-click the TIMS icon on the Control menu.
2. Click OK to confirm that you want to end your TIMS session.

Close Button
1. Click the Close button.

2. Click OK to confirm that you want to end your TIMS session.
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